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File Menu

The File menu includes commands for printing, or that enables you to send or receive files.

Send text file

Receive text file

Print

Exit



Edit Menu

The Edit menu provides commands for using the Clipboard, and clearing the buffers.

Copy

Paste

Clear



Options Menu

The Options menu provides access to options that affect the way the program operates.

Communications

Window

Font

Initialisation



Connections Menu

The Connection menu includes commands for connecting to other packet stations, disconnecting from 
them and returning the TNC to converse mode (break).

Break

Connect

Disconnect



YAPP Menu

YAPP(tm) protocol for Packet Radio binary file transfer (c) 1986, Jeff Jacobsen - WA7MBL

The YAPP menu has the commands for up and down loading binary files.

Up load

Down load



Send Text File

Send the contents of a text file to the TNC.    This calls the File dialogue to select the desired file.



Receive Text File

Copy either the Whole Buffer, a Selection of text, or Echo the incoming text, or cancel text being "echoed"
to a file from the File dialogue.

If Text is being echoed to a file, then a "check mark" will be displayed on the menu, and the file name is 
shown in the Status window.

If the "check mark" is not displayed on the menu, then the File dialogue is called.



Print

Print either the Whole Buffer, a Selection of text, or Echo the incoming text, or cancel text being "echoed" 
to the printer from the Print dialogue.

If Text is being echoed to the printer, then a "check mark" is displayed on the menu, the Status window 
will show that it is printing.

If the "check mark" is not displayed on the menu, then the Print dialogue is called.



Exit

Selecting this closes the program.



Copy

Copy the selected text from the transmit window or the receive window to the clipboard.    Selecting text in
one window, will clear any selection in the other.



Paste

Paste text from the clipboard to the transmit window.



Clear

Clear the window buffers.

NOTE all the data in the buffers will be lost.



Communications

Set the parameters for communication with the TNC with the Communications dialogue.



Window

Set the Window parameters using the Window dialogue.



Font

Set the Text parameters using the Font dialogue.



Initialisation

Set the Start up and Shut down files using the Initialisation dialogue.



Break

This menu item sends a Break Signal to the TNC.



Connect

Select from a list of previous contacts using the Connection dialogue.



Disconnect

Sends a disconnect command to the TNC.



Up load

Send a binary file using YAPP file transfer protocol.    The file to be sent is selected using the File 
dialogue.

To send a file to a BBS or other automatic YAPP server, start the server before selecting this menu option.

To send a file to another station, not a server, select this when the other station is ready to receive.



Down load

Receive a binary file using YAPP file transfer protocol. The directory in which the file is to be stored is 
selected using the YAPP Receive File dialogue.

To receive a file from a BBS or other automatic YAPP server, start the server before selecting this menu 
option.

To receive a file from another station, not a server, select this when the other station is ready to send.



File Dialogue

The File dialogue box is for selecting a file for the following:

To transmit for Send text file.

To save to for Receive text file (as in the above example).

To use as an Initialisation file.

To Up load using YAPP file transfer.

File Name
The name of the file.    This must be an existing file for file send, or either a new file, or an existing
one for file save.

For Receive text file if the file exists, you will be prompted to overwrite it.    Selecting Yes will 
overwrite, No will append the new data onto the end, and Cancel will stop without saving.

Directory
This displays the name of the current directory.

Files
This shows a list of files in the current directory.

Directories
This shows a list of the directories in the current directory.



In the centre of the dialogue box are three radio buttons for Receive text file.    These are, from left, Buffer,
Selection, and Echo.    They select what is to be saved.    If a selection is unavailable, eg, no text selected,
then that button will be greyed out.    All the buttons will be greyed out for the other options.



Print Dialogue

The Printer dialogue box allows you to control your printing.

At the top is a drop down list box, containing a list of all the printers installed on your system.    If you wish 
to use a printer that is not installed, you must install it from the Control Panel.

In the centre of the dialogue box are three radio buttons.    These are, from left, Buffer, Selection, and 
Echo.    These select what is to be printed.    If a selection is unavailable, eg, no text selected, then that 
button will be greyed out.

At the bottom of the dialogue box are four buttons.    These are from left, OK, Cancel, Setup, and Help.

OK Signals to the computer to print.

Cancel Returns to the program without printing.

Setup Calls the printer setup dialogue box



Communications Dialogue

The Communications dialogue box allows you to control how the Computer talks to the TNC.

Baud Rate
The Baud Rate is selectable to one of 1200, 2400, 4800, or 9600 baud.

Data Bits
The number of Data Bits in a character can be either seven or eight.    NOTE for binary transfers, 
or the extended ASCII characters this must be set to eight.

Connector
This tells the program which RS-232 port is connected to the TNC.

Flow Control
The type of handshaking used between the computer and the TNC can be either Xon/Xoff, 
Hardware, or None.

Parity
To allow some form of rudimentary error checking, a Parity bit may be specified.    NOTE this 
parity setting must match that of the TNC, or the data may be garbled.

CR/LF on CR
Transmit Send both a carriage return and a line feed instead of just a carriage return.

Receive Converts carriage return only into courage return and line feed.



Window Dialogue

The Window dialogue box allows you to control how the Transmit and Receive windows are set.

Buffer memory
Specifies the amount of memory to be allocated to each buffer in kilo bytes (1024 bytes).

Maximum of 1024Kbytes.

Minimum of 1Kbyte.

Maximum line width
Select between eighty and one hundred and twenty characters to a line.

Wrap around width
Set the number of characters after which typing a space in the transmit window will generate a 
new line.



Font Dialogue

The Font dialogue box controls which font, which colours and the Tab settings for the text used by the 
program.

Tab Width
Set the number of spaces to separate each tab point.

Font
Select the font for use by the program, in the transmit and receive windows.

RX Colour
Set the colour to display received text from the TNC.

TX Colour
Set the colour to display transmitted text, sent to the TNC.



Initialisation Dialogue

The Initialisation dialogue box controls whether a file is send to the TNC on Start up or Shut down and 
which files those are.

Start up file
Set whether a file is to be sent to the TNC on starting the program, by checking the tick box.

Set the file name of the file to be sent in the edit box.

Shut down file
Set whether a file is to be sent to the TNC on starting the program, by checking the tick box.

Set the file name of the file to be sent in the edit box.

Start up Browse button
Sets the name of the start up file using the File dialogue to select the desired file.

Quit Browse button
Sets the name of the shut down file using the File dialogue to select the desired file.

NOTE it is a good idea to put the full path name of a file, as changing the directory in the other file 
operations may cause problems otherwise.



Connect Dialogue

This dialogue box contains a list of stations that you have connected to.    If a station is not in the list type 
its call sign into the edit part of the list box.    This will be remembered for future use.



YAPP Receive File Dialogue

The YAPP Receive File dialogue box is for selecting a directory in which to store the file to be down 
loaded.    The file name for the file will be supplied by the station sending the file.

Directory
This displays the name of the current directory.

Files
This shows a list of files in the current directory.

Directories
This shows a list of the directories in the current directory.



About Dialogue

The Packet Controller About box, access from the Help Menu.

Contains:
Program version.

The percentage of free space in the Receive Buffer.    NOTE, this is a sliding buffer, once full the 
oldest data is lost as newer information is received.



Shareware Notice

This dialogue box appears each time you run the program until you register.

If you have registered click on the OK button to bring up the Registration Dialogue Box.

If you have not registered click on the Cancel button to clear this notice and continue.



Registration Dialogue Box

Enter your registration number.



Keys Help

There are a number of Hot key short cuts:

Alt+B
Ctrl+Shift+B

Send a break signal to the TNC.

Alt+C
Call up the Connections dialogue box.

Ctrl+Shift+C

Call up the Communications dialogue box.

Alt+D
Send a Disconnect signal to the TNC.

Ctrl+Shift+D

Call up the YAPP Down load dialogue box.

Ctrl+Shift+F
Call up the Font dialogue box.

Ctrl+Shift+I
Call up the Initialisation dialogue box.

Ctrl+Shift+P
Call up the Print dialogue box.

Ctrl+Shift+R
Call up the Receive text file dialogue box.

Ctrl+Shift+S
Call up the Send text file dialogue box.

Ctrl+Shift+U

Call up the YAPP Up load dialogue box.

Ctrl+Shift+W
Call up the Window dialogue box.

Shift+Insert
Paste text from the clipboard.

Ctrl+Insert
Copy selected text to the clipboard.





Registration

Registering your copy of PktWin cost £25.00 with £2.00 shipping (£5.00 overseas).    If you wish to 
upgrade via EMail then shipping cost do not apply.

If you wish to register please send a cheque or money order (made payable to P.M.Hounslow) to:

Paul M. Hounslow
53 Leighton Court,
Copperdale Close,
Reading,
BERKS,
England.
RG6 2SG

Tel: 0734 864055

EMail: ssrhouns@reading.ac.uk

If you have any other comments, suggestions, or queries than please let me know.



Dialogue Boxes

A Dialogue box is a "pop-up" window, that allows you to change things within a program.



Configuration File

A record is kept of all the initial preferences for such things as:

Serial port settings (Baud rate, etc.).

Window Buffer sizes.

Text fonts and colours.

This information is kept in the file "PKTWIN.INI", in the Windows directory.



Whole Buffer

This selects the whole of the receive buffer.



Selection

This takes just the selected (highlighted) text in either the receive or the text buffer.



Echo

This copies incoming text as it arrives.



Transmit window

The lower of the two windows, this is where you type the text to be sent.



Receive window

The upper of the two text windows, this is where the incoming text, from the TNC, goes.



Status window

The "3-D" grey bar in between the two text windows, this tells you about the following:

Receive window scrolled.

Transmit window scrolled.

Insert/Overwrite text mode.

Printer echoing on.

Receive file being echoed.



Insert/Overwrite

Pressing the "Insert" key on the keyboard, switches between overwriting the character under the 
character cursor, or inserting one before it.



Menu Check Marks

A Menu Check Mark, in this instance, is a small "tick" mark to the left of a menu option.

For example:



Break Signal

This is used to return a TNC to Command mode from Transparent or Converse mode.



Greyed Selections

If a menu or dialogue box item is not relevant to a particular operation then that selection will be signalled 
as unavailable.    The most common form of signalling that an object is not available is to print it using 
grey ink.



Buffers

The text windows store their contents in two buffers, one for the Receive window, and one for the 
Transmit window.    Each of these buffers is First In First Out, that is when they become full, the oldest 
data is discarded.    They can be any size from one kilo byte to one thousand kilo bytes.



Baud Rate

The speed at which the data bits are sent "down the wire" to the TNC is known as the Baud Rate.    The 
computer and the TNC must be set to the same rate.



Handshaking

To enable either the TNC or the computer to control the rate at which data is received, the receiving end 
of an RS-232 connection can request that the transmitting end stop sending.    When it wants some more 
characters, it can then ask the transmitter to start sending again.    This process of flow control is known 
as handshaking.    Without some form of handshaking, incoming characters may be discarded, resulting 
in a loss of data.



Initialisation Files

These files are to allow you to change the configuration of the TNC when starting or closing the program.  
The Start up file is sent when starting the program, and the Shut down file is send when quitting.    These 
files may be any text files you like.



OK Button

This button accepts the current settings in the dialogue box.



Cancel Button

This button cancels to operation of the dialogue box.    Any changes will be lost.



Help Button

This button calls up help on this dialogue.



Abort Button

This button stops the operation.



Printer setup

This button calls up the printer setup dialogue box.



OK

This button calls up the registration dialogue box.



Cancel

This button closes the Shareware Notice.




